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Additional Resources

In addition to these Release Notes and HTML Help, Tecplot 360 includes access to these manuals to help you 
explore all of Tecplot 360’s functionality.

• Getting Started Manual Your introduction to Tecplot 360 includes a tutorial that will help you learn 
your way around the product.

• User’s Manual This manual provides a complete description of working with Tecplot 360 EX features.

• Scripting Guide This guide provides macro command syntax and information on working with macro 
files and commands.

• Quick Reference Guide This guide provides syntax for zone header files, macro variables, keyboard 
shortcuts, and more.

• Data Format Guide This guide provides information on outputting simulator data to Tecplot file 
format.

• Installation Guide These instructions give a detailed description of how to install Tecplot 360 on your 
machine.

My Tecplot
My Tecplot is Tecplot’s one-stop portal that allows you to download software, manage your license keys, and 
more. Visit it at https://my.tecplot.com/.

https://my.tecplot.com/
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Welcome to Tecplot 360 2023 R1

Tecplot 360 2023 R1 HOE Release Notes
This Tecplot 360 2023 R1 has all the features of Tecplot 360 2022 R2, plus support for high order elements! 
Highlights of high order element support are:

• Ability to read P2, P3, and P4 elements from CGNS, SZPLT, and VTU files.

• TecIO includes new APIs to write SZPLT files containing high order elements utilizing the new 
FEMixed Zone Type. CGNS node ordering is expected. See the CGNS documentation.

• High order elements are both selectively and recursively sub-divided, using the basis functions, to 
provide highly accurate results.

• Number of sub-divisions can be defined on a per-frame basis using new options in the Plot Sidebar. 
Higher levels of sub-division provide more accurate results, but also require more RAM and processing 
time.

Benefits of using Tecplot 360 for High Order Elements
• Smaller output files. Many high order element codes export grids that are pre-subdivided. This 

drastically increases the size of the data on disk, even in areas of the simulation which may not be post-
processed. By allowing Tecplot 360 to dynamically sub-divide the grid, only in areas of interest (region 
of an iso-surface or slice), your code can write less data. Each level of sub-division results in roughly 8 
times the number of cells.

• 20.8x faster than ParaView with the same CGNS data. Plotting an iso-surface of Density takes 125.8 
seconds with ParaView 5.10 and only 6.0 seconds with Tecplot 360. Furthermore, ParaView only sub-
divides the surface data, meaning the iso-surfaces get no refinement. At 4-levels of sub-division 
Tecplot 360 takes only 65.5 seconds, which provides a more accurate result and is still nearly 2x faster!

https://cgns.github.io/CGNS_docs_current/sids/conv.html#unstructgrid 
https://cgns.github.io/CGNS_docs_current/sids/conv.html#unstructgrid 
https://cgns.github.io/CGNS_docs_current/sids/conv.html#unstructgrid 


5

Tecp lot 360 2023  R
1 H

O
E R

el ease N
otes

• Higher levels of sub-division provide more accurate answers and are especially effective for line 
extractions (like velocity profiles seen here), streamtraces, and rendering of boundary surfaces.

• Lower levels of sub-division are generally adequate for qualitative plots of iso-surfaces and slices. 
Higher levels of sub-division may be done, but it can be difficult to see the difference, so you may not 
want to pay for the extra accuracy.
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Known issues with HOE Data in 360 2023 R1
• Derivative and gradient calculations (e.g. Q-Criterion, Velocity Gradient) are not implemented and will 

cause a crash.

• P3 elements may have discontinuities between cells, causing holes in slices and causing streamtraces 
to terminate early.

• Extracting Contour Lines from FEMixed (aka HOE) zones will cause a crash.

• Extract Blanked Zone from FEMixed (aka HOE) zones will cause a crash.

• Precise Value Blanking in 2D plots with FEMixed zones does not precisely trim mesh lines along the 
constraint boundary.

• Extract Connected Regions scripting command does not work with FEMixed zones.

• Combine Zones add-on does not support FEMixed zones.

• Surface restricted streamtraces may disappear as you change the number of HOE sub-division levels. 
This is because the XYZ seed-point location may no longer coincide with the surface as additional 
curvature is introduced. You may have to delete and re-seed your streamtraces.

Additional Updates & Features
• PyTecplot 1.6.0: Mixed finite-element zone supported. High-order finite-element support added.See 

the PyPI changelog for a full list of updates. 

• CGNS data files output from CONVERGE CFD are now supported in Tecplot 360. Loading 
CONVERGE CGNS files may also be automated via a new PyTecplot API: load_converge_cgns(). 

• Gouraud (smooth) shading now takes into account sharp angles between cells (creases) for improved 
rendering. The crease angle may be adjusted using the Edge Details dialog. To restore the 2022 R2 
behavior, set the crease angle to zero.

https://pypi.org/project/pytecplot/1.6.0/
https://pypi.org/project/pytecplot/1.6.0/
https://pypi.org/project/pytecplot/1.6.0/
https://pypi.org/project/pytecplot/1.6.0/
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Bug Fixes
• Fixed a licensing issue associated with network license servers combined with a load balancer. Client 

machines experienced a message stating, “The connection to your license server has been lost...” and 
then after 5-10 minutes, connection to the license server would be restored.

• Fixed an issue assigning solution time values to .vtu files. Time information in vtu data files identified by 
TimeValue is now read and used to properly assign solution time values when loaded into Tecplot 360.

• Fixed an issue where ASCII files wrote-out invalid variable sharing lists. If a user created a shared 
variable, then wrote out this variable along with additional variables, an error was given when 
attempting to load that file.

• Fixed a crash when extracting vortex cores for some Plot3D files.

Python Version Support
Tecplot’s Python support policy is to support the newest version of Python and the two previous versions. As 
of August 2023, we officially support Python 3.9, 3.10, and 3.11.

Platform Support
The 2023 R1 release is supported on the following platforms:

• Linux:

• Ubuntu 20.04 LTS, 22.04 LTS

• SUSE Linux Enterprise Desktop (SLED) 15

• RedHat 7.8+, 8, and 9

• CentOS 7.8+

• Rocky Linux 8 and 9

• Windows: 10 and 11

• macOS: 11, 12, and 13

Platform End of Life Updates
Ubuntu 18.04 LTS Standard Support ended April 2023. Current and future Tecplot product releases will not 
support Ubuntu 18.04 LTS.

Tecplot has discontinued support for macOS 10.15. Current and future Tecplot product releases will not 
support macOS 10.15.
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What Was New in Tecplot 360 2022 R2 Maintenance 
Release

Updates & Improvements
• Updated the Fluent Common Fluids Format (*.cas.h5/*.dat.h5) loader to support Ansys Fluent 2023 

R1!

• If you’ve seen the following error loading 2023 R1 Ansys Fluent files in Tecplot 360: 

Update to the latest release of Tecplot 360 to load Ansys Fluent 2023 R1 (*.cas/h5/*.dat.h5) files.

• Updated the legacy Fluent loader (*.dat/*.cas) to better handle transient data with particle zones. In the 
2022 R2 Maintenance release, solution times should be assigned correctly, and all particle zones 
should be grouped into the same time strand. 

• Updated the OpenFOAM loader to better handle surface data:

• This includes new support for boundary surface types such as zero gradient, symmetry, and wedge. 
In past 360 releases, surface zones of these types inherited values of zero for solution variables. 
After the update in this 2022R2 Maintenance release, these OpenFOAM surface zones will inherit 
solution variable values. For example:

• In previous versions of Tecplot 360, all the pressure values on the wing surface in the image 
below loaded in as zero values:
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• In the 2022R2 Maintenance release, pressure values are now nonzero on this wing surface:

• In addition, the Tecplot 360 OpenFOAM loader will now hide non-wall boundary surfaces by 
default on first load so that surface zones of interest can be quickly visualized (these surface zones 
can be shown in the Zone Style dialog). For example:

• For previous releases, OpenFOAM data sets showed all surface zones by default. In the image 
below, you can see the boundary surface zones shown on first load (covering the wing surface 
from view):
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• After the update, the boundary surfaces from the previous data set are hidden on first load, 
revealing only the wing surface by default:

• Updated the CFX loader to now support CFX 2023 R1.

• Updated the ABAQUS loader to now support ABAQUS 2023.

• PyTecplot: The supported Python version is now 3.9+ in PyTecplot 1.5.2. See the Python version 
support section

• PyTecplot: Documentation improvements.

• Updated the FreeType third party library to 2.13 to address open source software security concerns.

• Documentation improvements.

Bug Fixes
• Fixed an issue where images exported as borderless frames were not actually borderless but contained 

a faint line artifact on one or more edges of the image.
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• Before fix (faint line on two of the edges of image below):

• 2022 R2 Maintenance release (truly borderless): 
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• Fixed a crash when exporting images using the Convert to 256 colors setting.

• Fixed a sporadic crash on startup on Intel macOS machines by updating the Qt 5 GUI toolkit.

• Fixed an issue in macOS builds where some drop-down menus were truncated.

• Fixed a crash caused when a zone deletion is undone if the blanking dialog is open.

• Fixed a crash after activating a 2nd value blanking constraint for some data sets.

• Fixed an OEM issue where error messages for incompatible data files were being displayed hundreds 
of times instead of once per load.

• Fixed an issue with Analyze > Calculate Variables where the calculated Cell Volume of JK- or IK-ordered 
zones was zero instead of correct, calculated values.

• Fixed a crash when loading *.ply ASCII files with “vertex_index” properties.

• Fixed a crash with Analyze>Calculate Variables when using SZPLT files and Analyze>Field Variables are 
not set.

• Chorus: Fixed a crash occurring when AuxFiles were not associated with the last CaseID. 

• PyTecplot: Fixed a crash on exit error message on macOS while exporting images using PyTecplot in 
batch mode. Note that in previous releases, PyTecplot scripts ran successfully and all images exported 
though error messages could be seen after batch scripts exited.
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TecPLUS Subscriptions
As of January 1, 2017, TecPLUS replaces Tecplot’s Software Maintenance Service (SMS). With TecPLUS, you 
get all the benefits of SMS, including:

• No-charge upgrades to Tecplot 360 during your subscription period

• Unlimited technical support

• One free hour of online training per year

Additionally, an active TecPLUS subscription gives you access to the following components, boosting your 
Tecplot 360 license to a whole new level of value:

• Tecplot Chorus

Our simulation analytics product for engineers who work with large numbers of cases. Previously, 
Chorus included Tecplot 360 to view individual cases’ data files; we’ve flipped that, and now offer 
every Tecplot 360 user access to this powerful tool.

• PyTecplot

Tecplot and the Python programming language reunite! PyTecplot works with your system’s installed 
Python and with popular Python tools like NumPy, SciPy, and Jupyter. PyTecplot features an easy-to-
use object-oriented approach to working with your data and plots using the engine that powers 
Tecplot 360.

• Tecplot SZL Server

When your data is too big to move around comfortably, you can install this lightweight server on most 
Linux hosts to quickly and securely access your remote data.

Your basic Tecplot 360 license is perpetual: even if your TecPLUS subscription expires, you will still be 
licensed to run any version of Tecplot 360 released while your subscription was active—forever.1 However, 
your access to these additional software components (Tecplot Chorus, PyTecplot, and Tecplot SZL Server) 
ends when your TecPLUS subscription expires.

Most Tecplot 360 users now receive a new license key annually, even those without TecPLUS. If you 
currently have a Tecplot 360 license with active SMS, you can receive a new license key that activates the 
TecPLUS features through My Tecplot or by contacting sales@tecplot.com.

Usage Data Collection
To help us better understand how our customers use our products and improve them further, Tecplot 360 
includes an analytics feature that reports user activity over the Internet using the Google Analytics™ 
platform. This feature tells us which dialogs you use and which controls you manipulate in them. However, to 
protect your privacy and trade secrets, we do not see names associated with your data (such as variable, 
zone, or file names) or the actual values of fields in dialogs, nor do we receive any information about you or 
your organization’s identity.

If you do not wish to participate in this program, turn off “Collect Anonymous Usage Data” in the Help menu.

We receive basic information about your operating system, product version, and license at each launch of 
Tecplot 360, even if you have opted out of the usage data program. This information is not tied to any usage 
data collected.

No usage data of any kind is collected if you do not have access to the Internet or if the Google Analytics 
service is blocked by a firewall.

1. While your license is perpetual, we cannot guarantee compatibility of today’s Tecplot products with future 
systems.

mailto:sales@tecplot.com
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Crash Reporting
Please help us make Tecplot 360 better by sending a crash report to us in the event that the application 
terminates unexpectedly.

On Windows, Tecplot 360 creates a crash dump file. You will receive a message indicating that a crash dump 
file has been created. Click Yes in this dialog to open the folder where the file is created. You can then e-mail 
the most recent .dmp file in this folder, along with a description of what you were trying to do, to 
support@tecplot.com.

On other platforms, no crash dump file is created. However, we urge you to send us a report anyway with as 
much detail as you can remember.

If you have a moment and a desire to be extra helpful, please re-open Tecplot 360 and choose Enable 
Diagnostic Logging in the Help menu. Then redo the steps you took to cause the crash. Tecplot 360 will 
record your actions as a macro file. If you are able to reproduce the crash, send the resulting .mcr file to us 
(along with the .dmp file if you use Windows). On non-Windows platforms, you can find the .mcr file in /usr/
tmp/tecplot_$USER/tpa_diagnostics.

Crash dumps and diagnostic macros are stored in a temporary folder and will be eventually be deleted by the 
system. There is no need to delete them manually.

Graphics Drivers
For best results, please make sure that you are using the latest graphics drivers compatible with your 
hardware and operating system. These can be obtained from your graphics adapter vendor’s Web site. Old 
versions may have issues with Tecplot 360 EX, especially with larger data sets.

• NVIDIA: https://www.nvidia.com/Download/index.aspx

• ATI: https://www.amd.com/en/support

• Intel: https://www.intel.com/content/www/us/en/download-center/home.html

Platform-Specific Notes
The following table outlines the support for various platform-specific features in Tecplot 360 EX 2023 R1.

Refer to the remainder of this section for issues specific to your operating system.

Linux Mac Windows

FLOW3D loader

ABAQUS loader

Excel Loader

Tecplot Chorus

Tecplot SZL Servera

a. The SZL Server runs only on Linux, but Tecplot 
360 running on any supported platform can 
connect to the server as a client

https://www.nvidia.com/Download/index.aspx
https://www.amd.com/en/support
https://www.intel.com/content/www/us/en/download-center/home.html
mailto:support@tecplot.com
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Windows
Your account must have administrator rights on your computer to install Tecplot 360 EX, or else right-click 
the installer and choose “Run as Administrator.”

Linux
• Temporary Directory

Tecplot 360 EX relies on being able to create temporary files in the system temporary directory. On 
Linux, this directory is typically /usr/tmp or /var/tmp. If your user account does not have permission to 
write into the system temporary directory, you can use a different directory either by setting the 
TMPDIR environment variable in your profile or by setting the TEMPFILEPATH in the tecplot.cfg file.

• Menu Shortcuts

Menu shortcut keys may not work if the NUM LOCK is on. You may set the NUM LOCK to turn off 
automatically at boot in your computer’s BIOS.

• SELinux

SELinux (provided with some Linux distributions) adds an extra layer of security. If you see this error 
message:

.//bin/tecplot.shared: error while loading shared libraries: .//lib/libtec.so: cannot 
restore segment prot after reloc: Permission Denied

Enter these two commands, replacing /path/to/tec360/lib with the actual path of your installed 
Tecplot 360 lib directory (your account needs sudo permission):

sudo chcon -v -R -u system_u -r object_r -t lib_t /path/to/tec360/lib/

sudo chcon -t texrel_shlib_t /path/to/tec360/lib/*

You can then run Tecplot 360 EX  without disabling SELinux.

Mac
• Keyboard Shortcuts

Previous versions of Tecplot 360 used the Control key for most keyboard shortcuts, rather than the 
Mac standard Command key. Tecplot 360 EX changes these shortcuts to use the Command key under 
Mac. Similarly, when rotating a 3D plot, you now hold down the Command key while dragging with the 
right mouse button. 

Note that the Alt key may be called Option on some Mac keyboards.

• Right Mouse Button

If your Mac’s mouse has only a single button, hold the Control key while clicking to access right-click 
functionality.

• Middle Mouse Button

There is no functionality in Tecplot 360 that requires a middle mouse button; however, it does provide 
some shortcuts. Users of single-button mice cannot emulate the middle button, but users of mice with 
two buttons can hold down Control while right-clicking if their mouse does not support a true middle-
button click.

Enjoy Tecplot 360 EX 2023 R1 and master the view
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